
File
New Create a new user file

Open Open an existing user file

Save Save the current file using its current name

Save As Save the current file using a new name

Print Print currently displayed list(s)



View
Exclusions Displays a list of foods that should be excluded

Inclusions Displays a list of some foods that can be included

Symptoms Displays all the symptoms and changes

Unclassified Displays a list of foods that cannot be classified.

Foods Displays all the foods and the of days they were 
eaten

History Displays a graph showing symptom histories.



Action

Generate Current Lists The lists of foods are produced. Can be used before 
the neural network connections have been updated.

Update Symptoms Opens a dialog so that symptoms can be added, 
updated or deleted. 

Create Day List Opens a dialog so that foods can be copied to the day
list from the master list and added to or deleted from 
the lists.

Update Connections The connections between the layers in the neural 
network are updated to reflect any changes in the 
foods and symptoms.

Generate Tomorrows Lists The lists of foods are produced using the updated 
neural network connections.

Relate Foods to Symptoms Produces a list of 'Day After Relationships'.

Change Options Opens a dialog so that the application options can be 
changed.



Basic Concepts
In extreme circumstances it is obvious that foods and drinks are a major influence on health 
and fitness.    Eat 5,000 calories a day and you will probably gain some weight.    On the other
hand, eat nothing and you'll die!    Most people know that certain foods will cause them some
problems while other foods will make them feel good.    Some people know that they are 
allergic to specific foods and they will avoid these foods.    Food allergies that do not result in 
an immediate reaction can be difficult to determine and may involve a variety of testing 
procedures and exclusion diets.    Food sensitivities are even more difficult to determine 
because they may not cause a reaction until some days after the food has been eaten.    

Food and Symptom Relationships

The Neural Network Approach



Commands
The command menus available on the menu bar.

File User file and printing operations

View Document display selections

Action Sequence of daily updates



Lists
The lists that can be produced.

Inclusions
Exclusions
Unclassified
Symptoms
Foods



Inclusions
Some of the foods that can be eaten are on this list.    Some foods will appear on this list 
most of the time, some will appear every few days and then stay on it for a few days, some 
will appear often for just one day and some will appear rarely.    The foods that do not appear
on this list, on the Exclusions list or the Unclassified list are not yet known to NeuroDiet and 
should be added when they are eaten. 



Exclusions
This is a list of foods that should be avoided.      Some foods will appear on this list most of 
the time.    These foods are ones that may be causing an adverse reaction.    Some foods will 
occasionally appear on this list and need only be avoided for a few days.    Any food that is 
not on this list may be eaten - it does not have to be on the Inclusion list.    



Symptoms
The symptoms list includes the current status of each symptom.    At the start of the day 
every symptom will have a status of "no change".    The status can be changed at any time 
during the day using the Update Symptoms command on the Action menu.



Foods
This is a list of all the foods currently in the file.    The days on which the food was eaten are 
marked '+'.    The current scores are also on this list.    Foods that have not yet been eaten or 
if it has not been eaten for 50 or more days are given an average score.    The foods list can 
be sorted in alphabetic or in score order - see Options. Foods can be added and removed 
from this list using the Create Day List command on the Action menu.



When a new symptom is added
When a new symptom is added it is included in the connection calculations and this may 
result in a slight disturbance of the neural network.    This disturbance will be corrected 
within a few update cycles.



When a new food is added
Any foods that are added will appear on both the day list and the master list.    This process 
assumes that you will add foods when you eat them for the fist time.    If you want to add 
new foods before you eat them then you can use the same process but clear the day list 
before pressing OK.    Any foods that are in the day list will be included in the neural network 
calculations.    



Managing Files
Each user has one file.    This file can be called anything but the obvious choice is your name.
The file contains all the data that NeuroDiet requires.    This data is very complex and the 
files cannot be examined using any standard viewer.    All the current and historical measures
of symptoms, foods, time, neural network nodes, connection and configuration data is held 
in this file.    

Your progress and the neural network calculations are dependent on the date and time held 
in the file moving forward.    The neural network support software needs this time based data
to calculate the intervals between updates because it is not very likely that the file will be 
updated at the same time every day.    If the date and time goes backwards for any reason 
then the results of the neural network calculations will be wrong.    NeuroDiet will warn you if 
the date and time on your PC has gone backwards.



Foods and Drinks
NeuroDiet does not differentiate between foods and drinks, both are considered to be foods. 
All foods should be considered to be different.    Similar foods and combination foods with 
similar ingredients should not be assumed to be the same.      After a few weeks it usually 
becomes obvious which foods follow the same patterns.



Symptoms and Measures
All changes in symptoms are relative to the previous day; better, worse or no change.    
Some symptoms can be measured exactly (eg. weight) while others can only be termed 
relative (eg. pain).    Either way NeuroDiet is only interested in relative symptoms. It is up to 
you to convert actual measures to relative symptoms.    In most cases this is not a difficult 
problem, just consider, is it worse, better or is it the same as the day before.



Update Symptoms
The list shows the state of each symptom.    On the first day the list will be blank.    At the 
start of the day the state shown will be that of the previous day.    The actual state is always 
set to "no change" at the start of the day.    The state of a symptom is changed by selecting 
it and then pressing the appropriate button.      The selected symptom can be deleted by 
pressing the Delete button.    New symptoms can be added to the list by pressing the New 
button.    When the changes have been made press the OK button.    The Update Symptoms 
dialog can be returned to at any time to make further changes.



Foods cannot be classified if they are not known to have been eaten.
Foods that have not been eaten for 50 or more days may not be classified.
Select Put in Inclusion List if you want to add them to your inclusion lists.
Select Put in Exclusion List if you want to add them to your exclusion lists.
Select List Separately if you don't want to add them to the inclusion or exclusion lists.



Create Day List
The Day List is created by selecting all the foods eaten that day in the Master List and then 
pressing the transfer button.    Foods that are not listed can be added by pressing the New 
button.    Foods can be deleted by selecting the food in the Day List and pressing the Delete 
button.    The Day list can be cleared by pressing the Clear button.



Update Connections
The layers of nodes (neurons) in the neural network are connected together in such a way 
that every node in each layer is connected to every node in the adjacent layers.    The 
strengths or weights of these connections need to be modified to reflect any changes to the 
symptoms and the foods eaten.    This process is quite time consuming.    A few foods may 
result in a delay of two or three seconds.    A few hundred foods may result in the 
connections being so numerous that a delay of a few minutes can be expected.    The 
number of symptoms will also have some impact on the time taken to update the 
connections but it will not be as noticeable as that produced by a large number of foods.



Generate Tomorrows Lists
The lists of foods for the following day are generated.    Up to five different Lists are 
generated. The display of the lists can be selected using the View menu.



The list of symptoms. Select one symptom to make any changes.



Press to indicate that selected symptom is better.



Press to set all symptoms to 'no change'.



Press to indicate that selected symptom is worse



Press to indicate that selected symptom has not changed



Press to input a new symptom



Press to delete the selected symptom



Press when dialog has been completed



Press to cancel dialog ignoring any changes



List of all foods.    Select any foods required for transfer to Day list.



Press to transfer all selected foods from Master list to Day list.



List of all foods eaten today transferred from Master list.



Press to add a new food to the Master and Day lists.



Press to delete the selected food from the Day list and optionally from the Master list.



Press to remove all foods from the Day list.



The first day
NeuroDiet has no advance knowledge of medicine, dietetics or you.    It learns from the 
information that you supply.    On the first day you must supply a list of one or more 
symptoms.    Click on the Update Symptoms icon in the tool bar or select it from the Action 
menu.    On the first day all the symptoms will be new so press the New button to add each 
symptom.    The state of each symptom is relative to the previous day.    On the first day you 
can set the state of each symptom to anything you like but NeuroDiet will not learn anything
because no previous day exists!    Symptoms can be added or deleted later so you don't 
have to be too specific on the first day.    Press the OK button when you have finished 
entering your symptoms.    

Before proceeding you should save your newly created file.    You can call it anything you like 
but the obvious choice is your name.

When you have set up your list of symptoms and saved it you will then be able to set up the 
first days list of foods and drinks.    To do this click on the Create Day List icon in the toolbar 
or select it from the Action menu.    All the foods that you eat on the first day will be new so 
press the New button to add each food.    Press the OK button when you have finished 
entering the foods and drinks for the first day.    

After creating the day list click on the Update Connections icon in the toolbar or select it 
from the Action menu.    It may take a few seconds to update the neural network 
connections.

After updating the connections press the Generate Tomorrows Lists icon in the toolbar.    This 
will produce a list of foods to exclude and a list of some of the foods that can be included.    
The number of foods on each list will be very small because NeuroDiet is only aware of the 
foods that you have just added.

Initially the foods will be given a randomly generated score so they may appear on either of 
the lists.    Even nearly identical foods may appear on different lists.    This is because 
NeuroDiet has not learned anything yet.

From the first day NeuroDiet will exclude certain foods just to encourage you to vary your 
diet.    The number of foods excluded for this reason should reduce over the next few days 
because NeuroDiet will start to learn which foods should really be excluded.    

When you have finished save your file and exit NeuroDiet.



Water
Do not include water in your list of foods and drinks.    It is important to exclude water from 
the inputs to the neural network because it may be temporarily excluded from the diet while
the pattern of food and symptom reactions is established.    No other foods or drinks fall into 
this category - water is the only substance that must not be excluded.    



The first week
During the first week NeuroDiet will start to learn the way your symptoms react to the foods 
you eat.    It will also put some foods on the exclusion list even though you may not be 
reacting to them.    It does this to try to make sure that you vary your diet.    NeuroDiet 
cannot learn anything if your symptoms or foods do not vary.    You should make every effort 
to avoid the foods on the exclusion list.    



After 30 days
When you have been using NeuroDiet for 30 days you should know if it is discovering the 
foods that you may be sensitive to.    It is not possible to be certain about food sensitivities 
at this stage but some patterns should be emerging.    You are probably sensitive to the 
foods that stay on the the exclusion list for more than two or three days.      



After 50 days
After 50 days the number of foods on the inclusion list may start to increase.    Any foods 
that you have not eaten for 50 days are reintroduced onto the inclusion list to make sure 
that they have not been excluded without good reason.    As you use NeuroDiet it becomes 
more aware of any relationships between your symptoms and the foods you eat.    After 50 
days it knows your responses to various foods fairly well but it will now start to work 
dynamically because the foods eaten more than 50 days ago will not be considered when 
the neural network is retrained.    This is to ensure that your current symptoms and foods 
relationships are the ones that influence the neural network most.    This method of handling 
uneaten foods can be changed using Change Options in the Action menu.



Food and Symptom Relationships
Food and drink scoring is an obvious way to determine relationships between foods and 
symptoms.    Every food and drink is given 100 points and a note of all the foods eaten each 
day is made.    If the symptoms get worse then every food eaten on the previous day loses a 
point.    If the symptoms get better then the previous days foods gain a point.    After a few 
weeks the lowest scoring foods are the ones that cause problems.    Easy, can't fail, but it 
does.

The daily points scoring approach has two problems:

      
1.

The time of the reaction to the food may be after one day and 
the duration of the reaction may be more than one day.

It is possible to introduce a more complex scoring system so that
a number of days following the food can be considered.    With 
this method a different reaction curve needs to be assigned to 
each food.    The reaction curve for every food must first be 
established by eliminating all other foods.    An exclusion diet is 
needed just to determine when a reaction to a food is going to 
happen.    This has to be done for every food.    The reaction 
curves must be checked frequently and modified as needed.

      
2.

Reactions to food combinations may distort the true picture by 
appearing to be reactions to specific foods.

Few people would be able to eat a meal of kippers and custard 
served together without an immediate reaction but either food 
when combined with something more complimentary may not 
produce a reaction.    This is an extreme example of incompatible 
foods but it illustrates the problem.    Some meals may cause a 
reaction but they may not be such a distasteful combination.    



Weight and Fitness Control
It is possible to lose or gain weight by using NeuroDiet.    It is also possible to work out which 
foods and drinks are causing problems with your fitness program.    

If it is your intention to lose weight then you need first to work out a realistic target weight in
a specific length of time.    Consider your weight change to be a    symptom.    Work out how 
much you need to lose each day to reach your target weight.    Weigh yourself at the same 
time every day, preferably when you get up, before eating or drinking anything.    If you have
lost the required daily amount then your weight symptom status is better.    If you have not 
lost the required daily amount then your weight symptom status is worse. 

A similar approach can be used with your fitness program but it is not as easy to measure 
fitness.    If you use an exercise machine fitted with a meter this may be an approach to the 
measurement problem.    If you run daily then you may be able to judge your relative fitness 
based on how you feel immediately after your run.    Obviously the distance you run will 
interact closely with how you feel after your run.    



The Neural Network Approach
A neural network learns from examples.    Every day the foods and drinks consumed are 
presented to the inputs of a neural network and the symptoms and measurements are 
presented to the outputs.    The neural network is trained to relate the inputs to the outputs.  
After a few days some relationships emerge.    The trained neural network can be tested by 
presenting one food at at time to the inputs and measuring what happens at the outputs.    
The average reaction can be established and the foods that are above and below average 
can be determined.    After many days the neural network will learn all food and symptom 
relationships.    Unfortunately most neural network systems are static and require a large 
amount of data to learn anything useful.    NeuroDiet uses a dynamic neural network system 
that is capable of learning from a continuously changing situation.    The results of testing are
different every day giving a list of foods that should be avoided and another list of foods that
can be included.    Some foods are eliminated from the diet, some become a permanent 
feature of the inclusion list while others begin to fall into rotation patterns.    



The Example File
The example file is called example.ndt and it is included so that you can try the NeuroDiet
facilities before you start building up your own file.    The example file is a real user file.    If 
you think that the foods and drinks in the example file will be useful in your own file then it 
can be used as a starter file.    If you decide to use the example file as your file then you 
should save the file with a different name.    



When a food is deleted
When a food is deleted it is immediately removed from any calculations but its connections 
and name may remain until the neural network reconfigures.



When a symptom is deleted
When a symptom is deleted it is immediately removed from any calculations but its 
connections and name may remain until the neural network reconfigures.



After the first day
NeuroDiet works best if you update your file every day.    If you want to take a break see 
Skipping Updates.    

When you open your file you will see that the Update Symptoms icon is enabled.    Click on 
the icon in the tool bar or select Update Symptoms from the Action menu.    Select each 
symptom in turn and update its state.    The state of each symptom is relative to the 
previous day.    Press the OK button when you have finished entering your symptoms.    

You will now see that the Create Day List icon is enabled.    Click on the icon or select Create 
Day List from the Action menu.    Press the New button to add any new foods to the Master 
list and Day list.    Select all the foods that you have eaten (or are going to eat) today in the 
Master list.    Press the transfer button to copy all the selected foods from the Master List to 
the Day List.    Press the OK button when you have finished entering your foods.    

Now the Update Connections icon will be enabled.    Click on the icon or select Update 
Connections from the Action menu.    No further action is required during this stage but you 
may have to wait a few seconds while the neural network connections are being updated.    

Finally the Generate Tomorrows Lists icon will be enabled.    When you click on the icon 
tomorrows Inclusion and Exclusions lists will be produced.    Print the lists and use them as 
the basis for your meals tomorrow.    Remember you can eat anything that is not on the 
Exclusion list - it does not have to be on the Inclusion list.



Skipping Updates
You should try to update your symptoms and foods every day but if you can't then try to 
keep a record that includes how your symptoms are changing and which foods you are 
eating.    When you start using NeuroDiet again it will detect your missing updates and give 
you the opportunity to fill in the missing data.    It will produce an Update Symptoms and a 
Create Day List dialog for every day that you have skipped.    

If you don't have the information to fill in the missing days then NeuroDiet will make some 
allowance for the gap in its data the next time the neural network is reconfigured.    The 
disruption to the network will become less noticeable during the following days but some 
incorrect food classification must be expected.



Dockbar
The NeuroDiet Toolbar can be dragged to this area.    Click on the background of the Toolbar 
and drag it into this area.



How to Order NeuroDiet
NeuroDiet can be ordered by post, internet or telephone.    

When you start the shareware version of NeuroDiet the Reminder dialog will appear.    If 
you press the Order button another dialog will appear that you can use to view (and print) a
number of different order forms and information sheets.    These forms can also be viewed by
clicking the appropriate icon in the NeuroDiet folder.    Detailed ordering information is 
included on the forms.

You can pay for NeurDiet with cash,    cheque or credit card.    

Any currency is acceptable but UK £s or US $s are preferred.    

The full version of NeuroDiet costs UK £20 included postage.    This is the lowest price that 
it is available at because no currency transaction charges are involved.

The price to customers in the USA is fixed at US $39. 

Payment in any other currency should be the equivalent of UK £25. 

The non UK prices include extra costs of postage and the cost of currency transfer to UK £.



Limits
NeuroDiet does not work very well with more than ten symptoms.    The number of 
symptoms that NeuroDiet allows is twenty but warnings are produced if more than ten 
symptoms are added.    This is because the number of days required to find any relationships
between symptom changes and foods eaten increases very rapidly with the number of 
symptoms. It is not practical to use more than ten symptoms at a time. NeuroDiet works 
best with five or six symptoms.

The number of foods is not limited by NeuroDiet but the time taken to update the neural 
network connections increases with the number of foods in use.    Even with a fast PC a delay
of a few minutes can be expected with 200 foods but this delay may be as long as 30 
minutes with 2000 foods. 



Generate Current Lists
This is used to show the current food and symptom lists.    It can be used at any time.    It is 
not necessary to complete a daily update cycle before the current lists are available.    If the 
daily update cycle has not been completed the current lists will be todays inclusions and 
exclusions.    If the daily update cycle has been completed the current lists will be 
tomorrows inclusions and exclusions.



Change Options
NeuroDiet options apply to the application not to individual user files.

                                                            Click on the area of interest.

                    



Set the hour between 0 and 23 at which time you want NeuroDiet to start a new day. The 
default time is 04:00.



Select Alphabetic to list the foods in alphabetic order.
Select Score to list the foods in the current score order.



Unclassified
Foods that are not currently classified by NeuroDiet are either those that have been added 
to the Master list but not eaten or foods that have not been eaten for 50 or more days.    The 
foods that have not been eaten for 50 or more days retain the previously calculated score 
and may sometimes move to the other lists. Unclassified foods can be moved to the 
Inclusion or Exclusion lists using the Change Options dialog.



History of Symptoms
The graphs show how the symptoms have changed during the last 50 days.    The changes 
are those that were entered in the Update Symptoms dialog.    The graphs are automatically 
scaled to show relative values.    



Day After Relationships
This does not use the neural network so symptom changes due to food combinations and 
delayed reactions are not listed.    It is a simple check to see if any foods often result in a 
change in the symptoms.    Symptom changes are only considered if they are consistent.    If 
the symptom gets better at least four times.after eating a food without ever getting worse 
then it is put on the corresponding 'Best food' list.    If the symptom gets worse at least four 
times.after eating a food without ever getting better then it is put on the corresponding 
'Worst food' list.    



NeuroDiet
What to Do and What to Expect

The first day 
After the first day
The first week
After 30 days
After 50 days
When a new food is added
When a new symptom is added
When a food is deleted
When a symptom is deleted

Reference

Basic Concepts
Foods and Drinks
Symptoms and 

Measures
Managing Files
The Example File
Weight and Fitness 

Control

Skipping Updates Take a break from the daily update.
Commands The commands available on the menu bar.
Limits Limitations of symptoms and foods.
Lists The lists that can be produced.
Water Water is essential to life.





File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print 
Preview

Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Exit Exits NeuroDiet.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in NeuroDiet.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Drives
Select the drive in which NeuroDiet stores the file that you want to open. 

Directories
Select the directory in which NeuroDiet stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, NeuroDiet displays the Save As dialog box so you 
can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    NeuroDiet displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    NeuroDiet adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your NeuroDiet session.    You can also use the Close command on 
the application Control menu.    NeuroDiet prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in NeuroDiet, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in NeuroDiet,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    NeuroDiet displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, NeuroDiet displays the Save As dialog box.

Print the active document.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the NeuroDiet window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using NeuroDiet and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
NeuroDiet.



Context Help command 

Use the Context Help command to obtain help on some portion of NeuroDiet.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the NeuroDiet window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the NeuroDiet window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Neural Dietician is sending output to 
the printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.




